
Executive Summary
Prowess Consulting set out to determine which of the following—Microsoft Surface® devices, Apple® MacBook Pro® 

devices, or Apple® iPad Pro® devices—could provide the best overall user experience and productivity for workers, 

while reducing management and support needs for organizations. Our tests examined 10 common work scenarios 

involving typical tasks for office, creative, and mobile workers. We also looked at IT admin tasks required to manage 

and secure the devices. 

Specifically, our testing compared the following devices:

The results showed that workers using the tested Surface® devices can consistently perform tasks faster, more easily, 

and in fewer steps than those using the Apple® devices tested.

MICROSOFT SURFACE® DEVICES COME OUT 
ON TOP FOR WORKPLACE PRODUCTIVITY
Test results show that workers complete tasks faster and more easily on a 
Surface® device than a comparable Apple® device.

VS.

Microsoft Surface® Laptop,  
powered by an Intel® Core™ 

 i5 processor

Apple® MacBook Pro®, powered 
by an Intel® Core™ i5 processor

Microsoft Surface® Pro with 
Long-Term Evolution (LTE), 
powered by an Intel® Core™  

i5 processor

Microsoft® Surface Book® 2, 
powered by an Intel® Core™  

i7 processor

Apple® iPad Pro® with  
LTE, powered by an  

Apple® A10X processor

Apple® MacBook Pro®, powered 
by an Intel® Core™ i7 processor

VS.

VS.
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Surface Devices Consistently Outperformed Apple® Devices  
in 10 Tested Scenarios
Note: For full results, see Appendix A: Results Summary.

Scenario and Description Functional Area Value Statement

SCENARIO 1

Quickly organize and  
execute team meetings

Teamwork
2x faster and with 6 fewer steps to organize and execute team 
meetings on a Microsoft Surface® Laptop, compared to an Apple® 
MacBook Pro®.

SCENARIO 2

Develop shared  
documents collaboratively

Teamwork
8 percent faster for enterprise teams to develop content 
collaboratively with a Surface® Pro, compared to an Apple®  
iPad Pro®.

SCENARIO 3

Easily design a creative asset
Creativity

59 percent faster and with 17 fewer clicks to design a rich 
Microsoft® PowerPoint® presentation with 3D graphics using a 
touchscreen and pen on a Microsoft® Surface Book® 2, compared  
to a MacBook Pro.

SCENARIO 4

Securely manage devices
Security and 
manageability

169 percent faster and with 21 fewer steps to add and 
manage a Surface Laptop in a Windows® domain, compared to a 
MacBook Pro.

SCENARIO 5

Work efficiently on the road
Mobility

41 percent faster and with 14 fewer clicks to complete photo 
capture and editing tasks on the road by using only one, flexible 
device—the Surface Pro—compared to using a MacBook Pro and  
an iPad Pro.

SCENARIO 6

Log on quickly and easily
Productivity

3x faster to log on with a Surface Book 2, compared to a MacBook 
Pro. More than a full workday per year, per user, saved by 
logging on to a Surface device instead of a MacBook Pro.1

SCENARIO 7

Simplify teamwork using  
a digital whiteboard

Teamwork
41 percent faster and with 11 fewer taps for team members  
to collaborate on a whiteboard with a Surface Pro compared to an 
iPad Pro when using join.me®.

SCENARIO 8

Complete development 
workflows across a suite  
of applications

Productivity
25 percent faster for enterprise web developers to perform  
multi-app tasks on a Surface Laptop compared to a MacBook Pro.

SCENARIO 9

Efficiently create and  
publish an image portfolio

Productivity
67 percent faster and with 17 fewer clicks to organize, 
retouch, and publish photos online with a Surface Book 2 compared 
to a MacBook Pro.

SCENARIO 10

Switch between laptop  
and tablet modes

Simplicity
15 percent faster to perform typical office tasks on a Surface Pro, 
compared to an iPad Pro.
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Is There an Ideal Device for Modern Workplace 
and Creative Team Members?
The days of working on a stationary computer at a desk are disappearing rapidly. Modern 

business workers want the flexibility to get their work done anywhere, at any time. That means 

crunching numbers from an airport, scheduling meetings from home, attending a Skype® 

meeting on the train, editing graphics for a presentation during a taxi ride, docking to an 

external monitor in an office, and taking digital notes with a pen in a meeting.

But workers also demand convenience, simplicity, and performance from the devices they use. 

They need a multi-faceted tool for productivity that lets them minimize the number of devices 

and external peripherals they carry around all day. They want devices that make their work 

lives simpler and more enjoyable through a better hardware and software experience.

It’s not all about the end user, either. When employees enjoy a smoother, more convenient 

device experience, their companies reap the rewards through greater organizational efficiency 

and productivity, which helps the bottom line. That effect is magnified across dozens or 

hundreds of workers, where even small efficiency gains add up to hours, days, or weeks of 

savings over the course of a year.

At the same time, business IT personnel struggle to meet employee needs with devices they 

can keep more secure and up to date, within their limited budgets. Help desks want to shave 

support hours by reducing the number and types of devices they work with, and admins don’t 

want the extra time and complexity involved in managing devices that don’t work with existing 

domain-management tools.

Putting Devices to the Test
Microsoft promotes Microsoft Surface devices as ideal solutions for modern workers. Surface 

Pro, Microsoft® Surface Book® 2, and Surface Laptop devices all include touchscreens, which 

give users more ways to interact with apps for convenience and productivity. The Surface 

Pro and Surface Book 2 can both be used as laptops or tablets, which makes them ideal for 

sketching, writing, photo editing, and media consumption.

Apple also makes a strong case for having devices for office and mobile users. The iPad Pro 

is light, portable, and offers a touchscreen. It can also be used with add-on Apple Pencil® and 

keyboard accessories. The MacBook Pro is a powerful desktop PC that supports popular 

applications from Microsoft and other companies, but it does not have a touchscreen, and it 

can’t be used as a tablet.
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Prowess Consulting set out to compare these two sets of devices to determine which—if any—

could best meet the demanding requirements of modern users and admins while ensuring 

productivity of users and the IT staff that support them. For each scenario, we looked at a 

specific pair of devices: one Surface device versus one Apple device. Our engineers selected 

specific devices to reflect what organizations and workers would realistically use for each 

particular task, and to ensure each pairing of Surface and Apple devices would have similar 

price points and specifications for CPU and memory.

Real-World Scenarios
To create realistic test cases, our engineers investigated the use-case scenarios most 

applicable for workers and IT administrators in both enterprise and small and medium-sized 

business (SMB) environments. Our engineers also examined scenarios that include typical 

mobile and office use cases.

To cover those scenarios, we grouped testing into the following six key functional areas:

1. Productivity

2. Creativity

3. Teamwork

4. Security and manageability

5. Mobility

6. Simplicity

In addition, we wanted to ensure that the test scenarios included popular software applications 

that are required or frequently used by organizations, workers, and IT administrators. After 

reviewing several options, our engineers selected the following applications:

• Microsoft® Office 365®

• Microsoft Teams®

• Microsoft® Visio®

• Microsoft OneDrive®

• Microsoft® Visual Studio®

• Microsoft® System Center Configuration Manager

• join.me®

• Adobe® Lightroom®

• Adobe® InDesign®

• Adobe® Reader®

We then created 10 specific test cases built on real-world scenarios. Each test case compared 

a specific pair of devices: one Surface device and one Apple device, as shown in Table 1.
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Table 1. Tested scenarios and device pairs

Scenario and Description Functional Area Device Compared

SCENARIO 1

Quickly organize and execute team meetings
Teamwork

Microsoft Surface® Laptop vs.  
Apple® MacBook Pro®

SCENARIO 2

Develop shared documents collaboratively
Teamwork Surface® Pro vs. Apple® iPad Pro®

SCENARIO 3

Easily design a creative asset
Creativity Microsoft® Surface Book® 2 vs. MacBook Pro

SCENARIO 4

Securely manage devices
Security and 
manageability

Surface Laptop vs. MacBook Pro

SCENARIO 5

Work efficiently on the road
Mobility Surface Pro vs. iPad Pro 

SCENARIO 6

Log on quickly and easily
Productivity Surface Book 2 vs. MacBook Pro

SCENARIO 7

Simplify teamwork using a digital whiteboard
Teamwork Surface Pro vs. iPad Pro

SCENARIO 8

Complete development workflows across a 
suite of applications

Productivity Surface Laptop vs. MacBook Pro

SCENARIO 9

Efficiently create and publish an  
image portfolio

Productivity Surface Book 2 vs. MacBook Pro

SCENARIO 10

Switch between laptop and tablet modes
Simplicity Surface Pro vs. iPad Pro

Testing Through Personas
To replicate real-world scenarios, our engineers performed each test case from the perspective 

of a named persona: a typical worker conducting relevant steps to complete tasks specific to 

that scenario. Full steps for each scenario are listed in Appendix C.

Surface Devices Do More
In every comparison we tested, we were able to complete the task faster on the Surface 

device. The Surface devices were also easier to work with because they provided a  

more unified experience across Office 365 applications, with common, integrated features. 

They all supported touchscreen capabilities. And they worked seamlessly with external 

displays and peripherals.
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The Apple devices were often cumbersome for users because they did not offer a unified 

software experience across applications. In addition, workflows sometimes required users 

to switch between two devices—an iPad Pro and a MacBook Pro—in order to complete the 

same work that a Surface user could accomplish easily on one device.

In summary, our testing found that the Surface devices offered:

• Richer features

• Full support for Office 365 and other business-critical apps

• Easier integration into existing office infrastructure for management and support

• A more productive and collaborative experience for users, compared to the Apple devices

Based on our test results, IT decision makers comparing Surface and Apple devices for their 

organizations will find that Surface devices are more versatile, can save workers time, and are 

easier for users and IT personnel to work with.
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Test Scenarios
Each of the 10 scenarios is presented below with the full user experience and results. (See 

Appendix A for a summary of the results for all 10 scenarios.)

Scenario 1: Quickly Organize and Execute Team Meetings
Surface Laptop vs. MacBook Pro (Intel® Core™ i5 processor–based model)

SCENARIO

Rodrigo manages a team of product marketing specialists, and he regularly uses Microsoft® 

Outlook® to organize and schedule meetings. For efficiency, he includes detailed agendas in 

his meeting invitations, and he often adds photos to illustrate concepts for the team to review 

ahead of time. To work efficiently, he needs to be able to perform these tasks seamlessly.

Karen is in a similar managerial role, and she also schedules meetings in the Outlook client on 

her MacBook Pro and provides photos to her team.

RESULTS

2x faster and 6 fewer steps
to organize and execute team meetings on a Microsoft Surface®  

Laptop, compared to an Apple® MacBook Pro®.

Rodrigo was able to quickly schedule his meeting on the Surface Laptop by working in 

Outlook in Office 365. He created a new meeting, selected the time and date, added required 

attendees, and then used the built-in scheduling assistant to select a time that worked well for 

everyone. He then used the Insert Online Pictures function from within the Outlook client to 

attach an image for discussion in the meeting.

Karen followed a similar process on her MacBook Pro, but her device did not have a 

scheduling assistant. To determine availability for her required attendees, she had to send an 

email to her colleagues asking for their availability, wait for their responses, and then finally 

send out the meeting request. In addition, Karen did not have the Insert Online Pictures 

function on the MacBook Pro, so she needed to switch from Outlook to Safari®, search for and 

download a photo, and then return to Outlook to attach the image to her email.

In our testing, the added steps were cumbersome and doubled the time required to complete 

the task. Note that the time difference is based on the best-case scenario, where every 

attendee responds instantly to Karen’s request for availability. In reality, some participants 

could take hours to respond, which would significantly increase the lost time and reduce 

Karen’s productivity.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Schedule meetings in seconds: The Surface Laptop lets users make use of the built-in 

scheduling assistant in Outlook to determine availability and schedule a meeting in one step.

• Enjoy a complete workflow from within one app: On the Surface Laptop, users can 

quickly locate and attach an online photo directly from Outlook, without needing to switch apps.
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Scenario 2: Develop Shared Documents Collaboratively
Surface Pro vs. iPad Pro

SCENARIO

Rahul is a manager heading up a new project to create a product brochure, and he needs 

to collaborate with his globally dispersed team members to share initial scoping documents. 

He and his colleagues are using Microsoft Teams on their Surface Pro devices to schedule 

and attend meetings, and to collaborate by sharing and collectively editing Microsoft® Word 

documents and Microsoft® PowerPoint® slides.

Rahul’s colleague, Tomas, also needs to collaborate with colleagues, but he is working  

on an iPad Pro.

RESULTS

8 percent faster
for enterprise teams to develop 
content collaboratively with a  
Microsoft Surface® Pro, compared 
to an Apple® iPad Pro®

More than 72 
workdays per year 
saved, for 200 workers conducting 
only two teamwork sessions per day 
on a Surface® Pro, compared to an 
iPad Pro.1

72

On the Surface Pro, Rahul was able to use Microsoft Teams as an end-to-end tool for 

teamwork. He created a Microsoft Teams channel for his project, created a meeting request 

for the new channel, invited users, and then used the built-in scheduling assistant to determine 

availability for all participants. He added a PowerPoint file to the invite and scheduled the 

meeting. During the meeting, Rahul opened and shared the PowerPoint presentation from 

OneDrive. Participants were able to collaborate by discussing changes and editing the 

document in real time during the meeting.

Tomas ran into limitations trying to do the same workflow on his iPad Pro. When scheduling 

the group meeting, he did not have access to a scheduling assistant on the iPad Pro, so he 

had to ask participants for their availability from a chat session, note all their available times, 

and then open Outlook to schedule the meeting. Tomas was also slowed by the way the iPad 

manages files. By default, the iPad saves PowerPoint files to iCloud®. Before he could share 

the PowerPoint file with his colleagues, Tomas needed to reopen the file in PowerPoint, tap 

Save a Copy, and then specify the OneDrive folder where he shares files with his colleagues.
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Because of the limited functionality on his iPad Pro, Tomas experienced a slower workflow 

that hindered collaboration. Conversely, Rahul’s experience was seamless on the Surface 

Pro, which enabled faster, more productive teamwork. Although each individual collaboration 

time difference was small, the collective time for multiple meetings per day for hundreds of 

workers over a standard work year would be considerable. If an organization had 200 workers 

collaborating in just two meetings per day, the time savings for Surface Pro users would add 

up to more than 577 hours—more than 72 workdays saved. That’s equivalent to an employee’s 

full calendar quarter of time saved.1

WHY THE SURFACE DEVICE PERFORMS BETTER
• Schedule a meeting in seconds. The Surface Pro simplifies meeting creation by integrating 

with Office 365 to automatically show the availability of all participants.
• Enjoy an end-to-end, integrated experience with Office 365. Users enjoy full integration 

of Office 365 apps within Microsoft Teams on the Surface Pro, which enables an end-to-end 
experience without needing to switch between apps.

• Enjoy a richer collaboration experience in Microsoft Teams. Surface Pro users enjoy a 
full teamwork experience because they can co-author files on a call within Microsoft Teams. iPad 
Pro users must open files from within their associated apps and then upload the changes to a 
shared drive before other teammates can see the changes.
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Scenario 3: Easily Design a Creative Asset
Surface Book 2 vs. MacBook Pro (Intel Core i7 processor–based model)

SCENARIO

Meghan is a middle school teacher who uses PowerPoint in her classroom. She regularly 

includes 3D graphics to help retain student interest, and she likes to draw on the slides in 

addition to using built-in shapes. She performs these tasks on her Surface Book 2 using the 

Surface Pen and touchscreen functionality and the 3D graphics feature of PowerPoint.

One day, her IT department asks Meghan to test a MacBook Pro for her daily use. She tries to 

perform the same steps on the new device.

RESULTS

17 fewer clicks 
on the Surface Book 2 means 
workers can design presentations 
faster, without cumbersome  
workarounds.

59 percent faster 
to design a rich Microsoft® PowerPoint® 
presentation with 3D graphics using a 
touchscreen and pen on the Microsoft® 
Surface Book® 2, compared to the 
Apple® MacBook Pro®.

Meghan was able to work 59 percent faster on the Surface Book 2 than on the MacBook Pro. 

Her work on the MacBook Pro was slower because the device does not include a touchscreen 

or pen. As a result, many of Meghan’s tasks took more steps and more time.

The additional steps are just part of the story for Meghan. The MacBook Pro does not provide 

the same rich support for 3D graphics as the Surface Book 2, so Meghan needed to use 

a browser to find comparable images online, and then copy and paste those images into 

PowerPoint. Meghan was also hindered by the lack of support for a touchscreen and pen on 

her MacBook Pro. Manipulating and altering graphics was a time-consuming struggle with a 

touchpad, and she had to forego hand-written notes altogether.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Work faster and more creatively with a touchscreen and pen. Touchscreen 

capabilities and Surface Pen functionality with the Surface Book 2 enable users to work faster 
and with more creativity than on a MacBook Pro.

• Work natively with 3D graphics in apps. Built-in 3D graphics capabilities in PowerPoint 
on the Surface Book 2 allow users to get work done directly within PowerPoint, without having 
to use multiple apps.
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Scenario 4: Securely Manage Devices
Surface Laptop vs. MacBook Pro (Intel Core i5 processor–based model)

SCENARIO

Li is an IT administrator at a midsized enterprise. He works with a team of other admins to 

manage and secure more than 1,000 endpoint devices in his organization. His company is 

planning to roll out Surface Laptop devices during the next user-device upgrade, so Li and 

his team are preparing with a trial run. Li has the choice of using mobile device management 

(MDM) software or Active Directory® to help manage and secure devices, but his company 

has used Active Directory and System Center Configuration Manager for years because 

they provide granular control of device features and user access. He decides to use Active 

Directory and System Center Configuration Manager to disable cameras and USB storage 

devices on the Surface Laptop, in accordance with his company’s security policies. Then 

he connects a Surface Laptop to the enterprise infrastructure and adds it to the domain to 

automatically receive the domain policies.

Barbara is one of Li’s teammates, and she is responsible for managing Apple devices in the 

organization’s design and publishing department. She needs to join new MacBook Pro devices 

to the same network infrastructure and ensure they receive domain policies, including policies 

to disable the camera and USB storage devices.

RESULTS

Li was able to quickly and painlessly add the Surface Laptop to the existing Windows® 

operating system–based domain, where it automatically and seamlessly inherited all the 

required policies for management, including the policies Li configured earlier using System 

Center Configuration Manager. The Surface Laptop camera was disabled as intended, and 

users were successfully prevented from accessing external drives (such as thumb drives) from 

the USB ports on the Surface Laptop.

The process was quick and simple, and users would not be able to override the settings, 

even if they logged on to their devices as local admins. In addition, the USB policy settings in 

System Center Configuration Manager were extremely granular, which gave Li the ability to 

disable the use of USB storage devices, while still allowing users to plug in and use safe USB 

peripherals, such as keyboards, mice, or USB headsets.
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For Barbara, adding a MacBook Pro device to an existing Windows infrastructure required IT 

personnel with specific knowledge of Apple devices, added complexity and steps, and did not 

provide the same level of management or security as the Surface Laptop. To apply company 

settings to the new MacBook Pro, Barbara needed to log on to the device as a domain 

administrator, manually download, install, and run a System Center Configuration Manager 

client tool, and then reboot the device to receive the System Center Configuration Manager 

policy settings.

There was no way for her to enforce security for the MacBook Pro, because any user with 

technical knowledge would be able to bypass protections at startup to gain local admin rights 

and subsequently undo or change any of the settings Barbara applied to the device through 

System Center Configuration Manager.

In addition, Barbara discovered that disabling the USB ports on the MacBook Pro was not 

granular, like it was on the Microsoft Surface Laptop. On the MacBook Pro, the policy didn’t 

just prevent USB storage devices from being used, it completely disabled access to the port. 

That meant users would not be able to access safe peripherals, like keyboards and headsets.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Quickly and easily add new devices to your Windows domain. Surface Laptop 

devices are easy to add to any existing Windows domain infrastructure, where they inherit all 
required policies.

• Enjoy granular control of devices from System Center Configuration Manager. 
Settings on the Surface Laptop can be controlled easily and granularly by using System Center 
Configuration Manager.

• Protect devices from users bypassing corporate safeguards. Surface Laptop devices 
are protected from users overriding security policies because only domain admins can undo or 
change the policies and settings pushed down from the domain.
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Scenario 5: Work Efficiently on the Road
Surface Pro vs. iPad Pro

SCENARIO

As a real-estate agent, Melody spends most of her time in the field, showing houses and 

taking photos. She then adds those images to her listings brochure, which she shares with 

clients in an Adobe® PDF document. She needs a seamless experience to take photos, add 

the photos to her brochure using InDesign, and then export the brochure as a PDF document 

that she can share with her clients.

Sebastian is also a real-estate agent who spends the bulk of his time in the field. He wants to 

perform the same tasks, but he works with an iPad Pro.

RESULTS

41 percent faster 
and 14 fewer clicks
to take and edit a photo on the road 
using a Microsoft® Surface® Pro,  
compared to an Apple® iPad Pro®.

Use 1 flexible  
device
instead of two and work more  
productively with a Surface® Pro,  
instead of an iPad Pro and an  
Apple® MacBook Pro®.

A road warrior (such as a real-estate agent) relies on the ability to quickly take photos and 

create brochures and fliers in fully featured applications. On her Surface Pro, Melody was able 

to work with full-featured productivity applications, such as InDesign. These applications work 

in tablet mode or in laptop mode, which made it easier for Melody to complete all her tasks 

from one device.

By contrast, the iPad Pro does not support InDesign, so in order to produce fliers for his 

properties, Sebastian needed to switch from his iPad Pro to a MacBook Pro to complete the 

task. That meant transferring the image file from the iPad Pro to the MacBook Pro, which 

added steps and time. Because the MacBook Pro does not have an LTE network connection, 

Sebastian had to transfer his image to the MacBook Pro using the Apple® AirDrop® software 

feature, and then later transfer the completed brochure back to his iPad Pro in order to have it 

available to show clients. Sebastian wasted time switching between two devices—and he had 

to carry both with him throughout his day on the road. Sebastian also potentially put his files at 

greater risk because AirDrop defaults to using less-stringent security settings.
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In our testing, Melody could work an average of 41 percent faster than Sebastian when 

completing the same tasks. However, in practice, the difference for the two real-estate agents 

would probably be much larger because Sebastian consistently needs to pull out his MacBook 

Pro, power it up, log on, and then perform the file transfer. That adds up to a lot of wasted time 

and frustration for Sebastian.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Work with full-featured apps in Windows. Surface Pro users have access to full-featured 

productivity applications, like InDesign, which are not available on an iPad Pro.
• Benefit from a seamless, mobile experience. The Surface Pro includes a high- 

resolution camera and LTE data connection, allowing for a more seamless work experience  
for mobile workers.

• Work in laptop or tablet mode, as desired. The full-featured, flexible design of  
the Surface Pro enables mobile users to do everything with a single device,  
without compromise.
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Scenario 6: Log On Quickly and Easily

Surface Book 2 vs. MacBook Pro (Intel Core i7 processor–based model)

SCENARIO

Ruth, an enterprise employee, starts up her device and logs on when she arrives in the 

morning. In compliance with her IT department’s security requirements, Ruth dutifully shuts 

down her computer at night and logs off when away from her device for more than 20 minutes. 

She also locks her device when she leaves her desk. She logs on again every time she returns 

to her desk.

Mark, a colleague of Ruth’s, uses a MacBook Pro for work. He is equally conscientious about 

shutting down each night and logging off after 20 minutes of inactivity to help ensure company 

information is secure when the device is unattended.

RESULTS

3x faster 
to log on with a Microsoft® Surface 
Book® 2, compared to an Apple®  
MacBook Pro®: just look at the 
 screen and you’re in.

45 weeks/year 
saved 
for a 500-user organization using  
Windows Hello® near-instantaneous 
logons on a Surface Book 2, compared 
to typing passwords on a MacBook Pro.1

45

Whether restarting, unlocking the screen, or logging back on, Ruth was able to authenticate 

almost instantaneously on her Surface Book 2 with Windows Hello®. All she needed to do 

was look at the screen and the built-in camera used optical recognition to log her on, even in 

low-light conditions. Before her hands even touched the mouse or keyboard, she was securely 

logged on to Windows, her domain, and her Office 365 resources through single sign-on.

Mark's MacBook Pro includes an Apple® Touch Bar™ with Touch ID®, the Apple fingerprint 

sensor, but it doesn’t include support for Windows Hello. Mark could use Touch ID to quickly 

authenticate after a screen lockout, but he still needed to manually type in his password every 

time he restarted or logged out from the computer.

In our testing, it took Mark eighteen seconds to wake his device, enter his password, and 

access an Office 365 PowerPoint document every time he needed to log back on. That’s an 

average of 12 seconds longer than Ruth needs to perform the same steps.

Even if Mark only needs to log on once per day, that extra step adds up to nearly an hour 

per year (at 52 weeks per year). Add in restarts after macOS® updates or security patches, 

in addition to logons after automatic logoffs when he leaves his desk, and the lost time could 

increase considerably.
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For example, if he leaves his desk and experiences an auto-logoff just three times per day, 

he needs to start the device once per day, and he needs to reboot after a system update 

once per week, the lost time per year adds up to 3.64 hours.1 Extend that lost time across 

an enterprise of 500 workers and it adds up to 227.5 workdays of lost productivity, just from 

slower times to log on to the device.

Windows Hello offered Ruth additional security benefits, too, because the technology replaced 

her password with strong two-factor authentication based on a new type of user credential 

that is tied to her device and a biometric identifier or PIN. As a result, Ruth did not need to rely 

on weak or reused passwords that she could remember. Eliminating passwords also reduced 

her risk of falling victim to a security breach.

WHY THE SURFACE DEVICE PERFORMS BETTER

• Log on instantly using Windows Hello. Windows Hello provides a seamless, 

near-instantaneous sign-on experience for users on the Surface Book 2. It works 

effortlessly—even in low-light conditions—and saves users time and frustration.

• Improve user security with biometric, two-factor authentication. Windows 

Hello reduces the risk of having an unsecure or reused password stolen. That saves IT 

and users time and hassle from remediation.

• Authenticate across all domain resources, near instantaneously. Windows 

Hello works with single sign-on capabilities, so users are logged on everywhere without 

having to re-authenticate to different apps and resources.
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Scenario 7: Simplify Teamwork Using a Digital Whiteboard
Surface Pro vs. iPad Pro

SCENARIO

Jennifer and her team of remote workers collaborate regularly in an enterprise environment. 

They find that sharing ideas and group brainstorming are critical elements in the team’s 

success. Several times a week, remote team members need to work together on documents 

and drawings. Jennifer’s team uses Surface Pro devices with Surface Pen styluses.

Another enterprise team, led by Carlos, also wants to improve teamwork by working 

collaboratively in a digital whiteboard, but Carlos’s team has standardized on iPad Pro devices.

RESULTS

Nearly a dozen 
fewer taps
facilitates more teamwork between 
colleagues when using a virtual 
whiteboard on a Surface Pro,  
compared to an iPad Pro.

41 percent faster
for team members to collaborate on 
a virtual whiteboard with a Microsoft 
Surface® Pro compared to an Apple® 
iPad Pro®.

Jennifer’s team first tried working with join.me, a common collaboration tool used by both 

Windows and Apple users. On the Surface Pro, Jennifer was able to create and copy a 

workflow diagram image from Visio, a popular diagram and flowchart application. Jennifer then 

pasted the image into a join.me session and modified it with shapes and text.

When a colleague wanted to contribute additional design changes, Jennifer simply delegated 

the presenter role to him. The team could pass control to each other for full collaboration 

until satisfied with the changes. Jennifer then exported the image to OneDrive and sent the 

completed image to her manager from Outlook, for approval.

Carlos and his team had a different experience on the iPad Pro. Carlos shared out a 

whiteboard session in join.me. Visio is not supported on iOS®, so he switched to a browser 

to locate and copy a workflow image, and then pasted it into the join.me whiteboard session. 

He then modified the image with built-in shapes, lines, and text. But because join.me does not 

support delegating virtual whiteboard sessions on the iPad Pro, there was no way to simply 

hand off the session to a team member. Carlos had to save the join.me project as an image 

file, email it to one of his teammates, and then make his colleague a presenter. The colleague 

then opened the file in join.me, made additional edits while team members watched and 

commented, and then exported the project to OneDrive. Finally, the completed image file could 

be sent to Carlos’s manager from Outlook.
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For Jennifer and her team, the overall experience was much simpler on the Surface Pro. The 

same task took less time, fewer steps, and involved true collaboration. Teamwork on the iPad 

Pro was limited by missing functionality.

In addition, Jennifer’s team discovered they could simply use Microsoft® Whiteboard as a 

built-in collaboration tool on the Surface device, instead of installing join.me as a third-party 

application. Using Microsoft Whiteboard, her team shared ideas using shapes, images, and 

text by working with built-in tools and the Surface Pen. She saved the final project as an 

image file, and then shared it with her manager via Skype for Business. Microsoft Whiteboard 

made teamwork even easier for Jennifer’s team, and it increased the time savings even further 

compared to Carlos’s team working on iPad Pro devices.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Microsoft Whiteboard enables teamwork. Microsoft Whiteboard on the Surface Pro lets 

team members work together efficiently and in real time, wherever they are.
• Built-in apps and features simplify teamwork. The lack of a built-in whiteboard app on 

the iPad Pro makes teamwork more difficult. Teamwork with a third-party app  
is awkward and time-consuming, and it requires sending files repeatedly between  
team members.
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Scenario 8: Complete Development Workflows Across a  
Suite of Applications
Surface Laptop vs. MacBook Pro (Intel Core i5 processor–based model)

SCENARIO

As a web developer at a fast-moving company, Larry is used to getting urgent requests for 

code and page updates. Today, his project manager has sent a request to update a web app 

and to add a graphic to a website. Larry works on a Surface Laptop running Visual Studio.

Alecia is also a developer, but she works primarily on a MacBook Pro. Like many developers, 

she runs Visual Studio in Parallels Desktop® for Mac®, a Windows emulator, because she 

often develops Windows operating system–based software.

RESULTS

25 percent faster
for enterprise web developers to write code and collaborate with  
designers and managers on a Microsoft Surface® Laptop, compared  
to an Apple® MacBook Pro®.

Using his Surface Laptop, Larry made the required code change, and then recompiled 

the app. He then opened Microsoft® OneNote® and used his finger on the touchscreen to 

quickly sketch a simple drawing to show the graphic designer what she needs to design for 

the webpage. When done, Larry clicked Email Page from the OneNote taskbar and sent the 

page with his sketch to the graphic designer. Finally, he responded to the project manager in 

Outlook to let her know the task was complete.

Alecia ran the same scenario on her MacBook Pro. She made the necessary code changes, 

and then waited for the app to compile—a task that took measurably longer running in the 

virtual environment. Like Larry, she also needed to create a mock-up for her graphic designer, 

but she did not have a touchscreen on her MacBook Pro. Creating a simple drawing in 

OneNote was slow and awkward because she needed to work with the built-in trackpad 

instead of her finger on a touchscreen.

Larry completed the same task 25 percent faster on his Surface Laptop. The compile 

process was faster in Visual Studio running natively in Windows. In fact, the time difference 

would be considerably larger if Alecia needed to start Parallels Desktop from scratch before 

running and using Visual Studio.
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In addition, Alecia’s two-operating-system solution added cost and complexity for her and her 

IT department. The company would need to purchase separate licenses, address support 

issues, and provide software updates and security patches for both operating systems.

Finally, even the process of creating a simple drawing for the graphic designer was faster and 

easier for Larry, thanks to the built-in touchscreen on his Surface Laptop.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Enjoy a complete, end-to-end development workflow. Integrated support for Visual 

Studio, OneNote, and the touchscreen on the Surface Laptop allows for a smooth and 
seamless workflow.

• Develop Windows apps faster in a native environment. Developing for Windows 
operating system–based software can be done natively on the Surface Laptop, allowing 
developers to compile programs faster than on a MacBook Pro running Visual Studio in an 
emulated Windows environment with Parallels Desktop.

• Sketch quickly and easily on a touchscreen. The touchscreen on the Surface Laptop 
make simple on-screen sketches a breeze.
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Scenario 9: Efficiently Create and Publish an Image Portfolio
Surface Book 2 vs. MacBook Pro (Intel Core i7 processor–based model)

SCENARIO

Erin is a freelance photographer who does a lot of work for magazines. She uses Adobe 

Lightroom and Adobe® Photoshop® to retouch photos, and she shares those photos with 

customers using the portfolio capability in Lightroom. She uses a Surface Book 2 for  

her workflow.

Tobias is also a freelance photographer doing work similar to Erin’s. He works on a MacBook 

Pro and also uses Lightroom and Photoshop for editing.

RESULTS

Less than 1/2 the time
to organize, retouch, and publish photos online, using a Microsoft® 
Surface Book® 2 compared to using an Apple® MacBook Pro®.

With the Surface Book 2, Erin simply inserted her camera’s SD card into the card slot, 

transferred the photos to her device, and used Lightroom to import, organize, and perform 

basic edits to her photos. She then performed more detailed edits in Photoshop, where she 

made extensive use of the Surface Pen on the touchscreen to edit and retouch photos.

She enjoyed a more efficient experience with the pen on the Surface Book for delicate tasks, 

such as creating a drop shadow and removing dust specks. In addition, the flexible design of 

the Surface Book 2 allowed her to adjust the screen to her ideal position for working with the 

pen. After completing her edits, Erin saved her updated portfolio from Lightroom and shared 

the location with her manager for final approval.
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Tobias followed the same workflow as Erin on his MacBook Pro, but he ran into several 

obstacles and limitations. Because there is no SD card slot in the MacBook Pro, Tobias had 

to fumble through his bag for a dongle that he could plug into the solitary USB-C® port in his 

device. In addition, the lack of a touchscreen or support for a pen made detailed edits a chore. 

Tobias was forced to work with the touchpad, which slowed down his edits and was less 

precise. He considered using a Wacom® digitizing tablet for more precision, but that would 

add considerable cost, would require carrying another separate hardware device, and would 

potentially require yet another dongle.

WHY THE SURFACE DEVICE PERFORMS BETTER
• Edit photos quickly and efficiently with the touchscreen and pen.  

The Surface Pen and the touchscreen on the Surface Book 2 can improve speed and 
efficiency for creatives performing precise tasks. Complex selections and image cleanup are 
accomplished with only a few taps, compared to many clicks on the Apple device, which 
means users can spend less time editing images and more time creating them.

• Work at any angle with a fully adjustable screen. The hinged screen on the Surface 
Book 2 allows creatives to work at the ideal angle for their workstyle. Users can even convert 
the device into a tablet to hold in one hand while drawing or editing with a pen in the other 
hand, making it easy to edit in the field.

• Access cards and peripherals without a dongle. The built-in card reader on the  
Surface Book 2 simplifies the transfer of photos from a camera, allowing photographers to  
work more efficiently.
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Scenario 10: Switch Between Laptop and Tablet Modes

Surface Pro vs. iPad Pro

SCENARIO

Kumar starts every workday with his Surface Pro while it is docked at his desk. This lets him 

use multiple monitors and peripherals, which helps him be more productive. But he also 

attends many meetings, and works on the train ride home, so sometimes the tablet form factor 

is more convenient. With the Surface Pro, Kumar enjoys the benefits of a docked computer 

experience with a single lightweight device, but he can also use it as a tablet or a laptop while 

away from his desk.

Lara also needs to be productive as she moves from office desk to meeting to the train ride 

home, but she works on an iPad Pro. She enjoys the portability of her device, but doesn’t have 

an option to connect to an external monitor or easily connect to other peripherals at her desk. 

And although she has access to a keyboard with the iPad Pro keyboard cover, she doesn’t 

have the convenience of a mouse.

RESULTS

More than 3 
months
saved per year for 200 workers to 
perform typical office tasks using a 
Surface Pro instead of an iPad Pro.1

15 percent faster
to perform typical office tasks on a  
Microsoft Surface® Pro while moving 
from desk to meeting to commute, 
compared to an Apple® iPad Pro®.

3
At the office, Kumar connected his Surface Pro to the Microsoft Surface® Dock. That instantly 

let him work productively with an external monitor and gave him access to his peripherals, 

like his USB headset, external storage, and external keyboard and mouse. When he needed 

to attend a meeting, he simply disconnected the Surface Pro from the power/dock cable and 

took his laptop to the meeting room, where he could use the attached Surface keyboard cover 

to type notes in OneNote. In addition, he could quickly switch to an open Word document 

and use his Surface Pen to highlight some key sections for reference. On the train ride home, 

Kumar used the built-in LTE connection to initiate a Skype chat with colleagues and to share 

and edit the Word doc he marked up earlier.

Lara used her iPad Pro in the office, but she was not able to connect her device to external, 

peripheral devices, including a mouse. She also couldn’t easily extend her screen to a second 

display because the iPad Pro only supports that functionality through a special adapter that 

plugs into the charging port on the device, or wirelessly through Apple® AirPlay® or a third-

party app—but both options add cost and complexity. Because Lara did not have an adapter, 

she was forced to work on the smaller, built-in screen, and she was forced to constantly move 

her hand from the keyboard to the screen to make selections, instead of clicking with a mouse.
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On her commute, she initiated a Skype for Business chat, but she was unable to share her 

Word document directly in Skype for Business for collaborative editing. As a workaround, she 

needed to share the doc from Word, and then wait for her colleague to receive a notification, 

open the shared doc, review it, and respond. The extra steps added time and resulted in less-

effective teamwork.

Overall, Kumar experienced less complexity and more productivity. If he followed the same 

routine even just once per day, the time savings would add up to more than half a workday per 

year. Multiply that out to 200 workers in a small enterprise, and the savings are more than 101 

workdays a year—more than three months—all from using the flexible Surface device instead of 

the iPad Pro.1

 A Winner Surfaces
Today’s workers expect simplicity, convenience, and the freedom to work how and where 

they like. Many devices can offer one or two of those traits. But our testing shows that, of 

the devices tested, only the Microsoft Surface devices provide all three. Compared to the 

Apple products we tested, the Surface devices offer richer features, full support for Office 

365 and other business-critical apps, easier integration into existing office infrastructure for 

management and support, and a more productive and collaborative experience for users. The 

Surface devices also provided significant time savings and the ability to accomplish the same 

tasks in fewer steps.

For IT personnel looking to provide the best user experience, productivity, and flexibility for 

workers, our testing showed that the tested Surface devices will be a better choice than the 

tested Apple devices for most organizations.

WHY THE SURFACE DEVICE PERFORMS BETTER

• Go from docked office PC to laptop to tablet with one device. The Surface 

Pro converts seamlessly from a docked desktop computer at the office to a laptop 

during a meeting to a tablet while on the go, giving workers greater flexibility and a better 

overall user experience.

• Access external displays and peripherals from one, convenient dock. 

The Surface Pro provides full access to peripherals, including an external display, for 

improved usability and productivity.

• Get a full-featured app experience, whether you’re in laptop or tablet 

mode. The Surface Pro lets you stay productive and benefit from using full-featured 

Windows apps, whether you use the device as a laptop or a tablet.
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Appendix A: Results Summary

Scenario Description Devices Compared Time Faster for the 
Microsoft Surface® 
Device

Number Fewer 
Clicks for the 
Surface Device

Factor 
Faster for 
the Surface 
Device

Percent 
Faster for 
the Surface 
Device

1 Quickly organize and execute  
team meetings

Surface® Laptop vs. 
Apple® MacBook Pro®

0:00:48 6 2.17 117%

2 Develop shared documents 
collaboratively

Surface Pro vs. Apple® 
iPad Pro®

0:00:40 2 1.08 8%

3 Easily design a creative asset Microsoft® Surface 
Book® 2 vs. MacBook 
Pro

0:00:41 17 1.59 59%

4 Securely  
manage devices

Surface Laptop vs. 
MacBook Pro

0:03:09 21 2.69 169%

5 Work efficiently on the road Surface Pro vs. iPad Pro 0:00:30 14 1.41 41%

6 Log on quickly  
and easily

Surface Book 2 vs. 
MacBook Pro

0:00:12 5 3.00 200%

7 Simplify teamwork using a 
digital whiteboard

Surface Pro vs. iPad Pro 0:01:34 11 1.41 41%

8 Complete development 
workflows across a suite of 
applications

Surface Laptop vs. 
MacBook Pro

0:01:22 5 1.25 25%

9 Efficiently create and publish  
an image portfolio

Surface Book 2 vs. 
MacBook Pro

0:03:54 17 1.52 52%

10 Switch between laptop and  
tablet modes

Surface Pro vs. iPad Pro 0:00:56 6 1.15 15%

Appendix B: Hardware and Test Environment
Microsoft® Devices
Microsoft® Device Microsoft Surface® 

Laptop
Surface® Pro Microsoft® Surface Book® 2

Processor: Intel® Core™ i5-7200 
processor, 2.50–3.10 GHz

Intel Core i5-7300U processor, 2.60 
GHz

Intel Core i5-7300 processor, 1.90–3.50 GHz

Model Number: 1769 1807 1832

Storage: 256 GB solid-state drive 
(SSD)

256 GB SSD 256 GB SSD

Memory: 8 GB 8 GB 8 GB

Display: 13.5-inch, 2256 × 1504 (201 
pixels per inch [PPI])

12.3-inch, 2736 × 1824 (267 PPI) 13.5-inch, 3000 × 2000 (267 PPI)

Graphics:  Intel® HD Graphics 620 Intel HD Graphics 620 Intel UHD Graphics 620/NIVDIA® GeForce® GTX 
1050

OS: Windows® 10 Windows 10 Windows 10

Cellular Network: N/A 4G LTE N/A
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Apple Devices

Apple® Device Apple® MacBook Pro® MacBook Pro Apple® iPad Pro®

Processor: Intel® Core™ i5-7360U 
processor, 2.30–3.60 GHz

Intel Core i7-7267U processor, 
3.10–3.50 GHz

Apple® A10X processor, 2.34 GHz 

Model Number: A1708 A1706 1671

Storage: 256 GB SSD 256 GB SSD  256 GB SSD

Memory: 8 GB 8 GB 4 GB

Display: 13.3-inch, 2560 × 1600 13.3-inch, 2560 × 1600 12.9-inch, 2732 × 2048

Graphics: Intel® Iris® Plus Graphics 
640

Intel Iris Plus Graphics 650 12-core PowerVR® Series 7XT

OS: macOS® High Sierra macOS High Sierra iOS® 11

Cellular Network: N/A N/A 4G LTE

Software Applications and Versions

Software Microsoft 
Surface® Laptop

Surface® Pro Microsoft® 
Surface Book® 2

Apple® iPad Pro® Apple® MacBook 
Pro® (Intel® Core™ i5 
processor)

MacBook Pro 
(Intel Core i7 
processor)

Microsoft® 
Office 365®

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 Not applicable 16.11 16.11

Microsoft® 
Outlook®

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 2.72.0 16.11 16.11

Microsoft® 
OneNote®

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 16.11 16.11 16.11

Microsoft® 
PowerPoint®

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 Not installed 16.11 16.11

Microsoft® 
Excel®

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 2.12 16.11 16.11

Microsoft® 
Word

16.0.9226.2114 16.0.9226.2114 16.0.9226.2114 2.12 16.11 16.11

Microsoft 
Teams®

Not applicable 1.4.4.0 Not applicable 1.077.2018040503 Not applicable Not applicable

Microsoft® 
Visio®

Not applicable 16.0.9162.2152 Not applicable 1.12 Not applicable Not applicable

Microsoft 
OneDrive®

Included in Office 
365 subscription

Included in 
Office 365 
subscription

Included in Office 
365 subscription

Included in Office 
365 subscription

Included in Office 365 
subscription

Included in Office 
365 subscription

Microsoft® 
Visual 
Studio®

15.6.27428.2015 15.6.27428.2015 Not applicable Not applicable Not applicable Not applicable

join.me® Not applicable Not applicable Not applicable 4.19.1 Not applicable Not applicable

Adobe® 
Lightroom®

Not applicable Not applicable 1.2.0.0 Not applicable 20180131-1556-7f481f8 Not applicable

Adobe® 
InDesign®

Not applicable 13.1.0.76 Not applicable Not applicable 13.1 Not applicable
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Appendix C: Test Steps
Scenario 1: Quickly Organize and Execute Team Meetings
On the Surface Laptop:

1. Open Outlook.

2. Start the timer.

3. From the ribbon, click Home.

4. In the New section, click New Items.

5. Click Meeting.

6. Add four users in the To field.

7. In the Subject field, enter Product planning meeting.

8. In the Location field, enter Skype.

9. In the Description field, enter See attachment.

10. From the ribbon, click Insert.

11. From the Illustrations section, click Online Pictures.

12. Perform a Bing search for bulb.

13. Double-click the desired picture.

14. Select the first suggested time.

15. Click Send.

16. Stop the timer.

On the MacBook Pro:

1. Open Outlook.

2. Start the timer.

3. From the ribbon, click Home.

4. In the New section, click New Email.

5. Add four users in the To field.

6. In the Subject field, enter Important!

7. In the body text field, enter Product planning meeting - reply with availability.

8. Click Send.

9. Pause timer. Wait for responses. (Test recipients respond immediately by clicking Reply, entering their availability, and then clicking Send.)

10. Tabulate responses to determine an appropriate meeting time.

11. Restart timer.

12. From the ribbon, click Home.

13. In the New section, click New items.

14. Click Meeting.

15. Add four users in the To field.

16. In the Subject field, enter Product planning meeting.

17. In the Location field, enter Skype.

18. In the Description field, enter See attachment.

19. Open Safari.

20. Search for bulb.

21. Right-click the desired image, and then click Save image and save to Downloads.

22. Switch back to the New Meeting dialog box in Outlook.

23. From the ribbon, click Format Text.

24. Click Attach File, and then attach the recently download bulb image.

25. From the ribbon, click Organize Meeting.

26. Click Send.

27. Stop the timer.
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Scenario 2: Develop Shared Documents Collaboratively
On the Surface Laptop:

1. Start the timer.

2. Open Microsoft Teams.

3. Click Join or create a team.

4. Click Create team.

5. In the Team name field, enter Brochure Product Development, and then click Next.

6. Add two users to the team, and then click Close.

7. Click Join or create a team.

8. Click Create team.

9. In the Team name field, enter Legal, and then click Next.

10. Add one user to the team, and then click Close.

11. Click the More options icon next to Brochure Product Development team, and then click Add channel.

12. In the Channel name field, enter Brochure scope discussion, and then click Add.

13. From the sidebar, click Meetings.

14. Click Schedule a meeting.

15. In the Title field, enter Scope Discussion.

16. In the Details field, enter Let’s get together this afternoon and talk about the requirements for this new project. Action Item: 
Change brochure title to “New Title.”

17. From the Select a channel to meet in drop-down menu, expand Brochure Product Development, and then click Brochure  
Scope Discussion.

18. In the Invite People field, enter two user names.

19. Click Scheduling Assistant.

20. Click Schedule Meeting.

21. From the sidebar, click Teams.

22. Click the Brochure Scope Discussion channel.

23. From the sidebar, click Files.

24. Click Upload, select Brochure.pptx, and then click Open.

25. From the sidebar, click Meetings.

26. Select the newly created meeting.

27. Click Chat with participants.

28. Enter the following text: Hello team, I'm looking forward to meeting later today to talk about this new project. I've uploaded a 
sample of the type of brochure I would like created, please take a look before the meeting and have any assets ready that you 
might need to share. Click Send.

29. From the sidebar, click Files.

30. Click Upload, select Example Brochure.pptx, and then click Open.

31. Open PowerPoint, and then open Example Brochure.pptx from OneDrive.

32. From the menu bar, click Share.

33. Enter a name in the Invite people field, and then click Share.

34. The remote tester receives the shared link, opens the file, and edits the presentation title:

a. Open Microsoft Outlook.

b. Open the new email message and click the link in the email to open the PowerPoint presentation.

c. Revise the slide title to “New Title.”

d. Click Save.

e. Click Share.

After the remote user completes the edits:

35. From the bottom of the Share sidebar, click Get a sharing link, and then click Create an edit link. Click Copy.

36. Return to Microsoft Teams. 

37. From the sidebar, click Teams.

38. Under the Legal team, click the General channel.
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39. In the Chat window, paste and send the link.

40. Enter a message for the legal team: Please review and approve the brochure.

41. Stop the timer.

On the iPad Pro:

1. Start the timer.

2. Open the Microsoft Teams app.

3. From the menu bar at the bottom, tap Teams.

4. At the top of the Teams sidebar, tap the Manage teams button, and then tap the plus icon.

5. In the Name field, enter Brochure Product Development, and then tap Done.

6. In the Add people dialog box, add two users to the team, and then tap Done.

7. At the top of the Teams sidebar, tap the Manage teams button, and then tap the plus icon.

8. In the Name field, enter Legal, and then tap Done.

9. In the Add people dialog box, add two users to the team, and then tap Done.

10. Tap the three-dots icon next to the Brochure Product Development team.

11. Tap Manage Channels.

12. Tap the plus icon to create a new channel.

13. In the Name field, enter Brochure Scope Discussion.

14. In the Start a new conversation field, enter What is your availability to talk about the requirements for this new project? Tap the 
Send icon, and then tap Save.

15. Wait for a reply. (The other testers reply immediately to the message.)

16. Open the Outlook app.

17. Tap the Calendar icon.

18. From the top menu bar, tap the plus icon.

19. In the Title field, enter Scope Discussion.

20. Tap the meeting time, and then change the start and end times to the previously agreed-upon meeting time.  
Tap the check mark to close the dialog box.

21. Tap Description, and then enter Let's get together and talk about the requirements for this new project. Action Item: Change 
brochure title to “New Title.” Tap the check mark to close the dialog box.

22. Tap Location.

23. In the Enter a place field, enter Brochure Scope Discussion Channel, and then tap the name to close the dialog box.

24. Tap People.

25. Add two users to the meeting, and then tap the check mark to close the dialog box.

26. Tap the check mark to send the meeting request.

27. Switch back to the Microsoft Teams app.

28. From the menu bar at the bottom, tap Teams.

29. Expand the Brochure Product Development team.

30. Tap to select the Brochure Scope Discussion channel.

31. In the chat field, enter Ron, would you please upload the brochure to the team files? Tap the Send icon.

32. In the Chat field, enter I've uploaded a sample of the type of brochure I like created, please take a look before the meeting and 
have any assets ready that you might need to share, and then tap the Send icon.

33. Open the PowerPoint app.

34. From the menu bar on the left, tap Open.

35. Open Brochure.pptx from iCloud®.

36. Tap File, and then tap Save a Copy.

37. Save a copy of the file to a OneDrive folder.

38. Tap Share, and then tap Invite People.

39. Tap the plus icon, add a user to share the file with, and then tap Send.
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40. The remote tester receives the shared link, opens the file, and edits the presentation title:

a. Open Microsoft Outlook.

b. Open the new email message and click the link in the email to open the PowerPoint presentation.

c. Revise the slide title to “New Title.”

d. Click Save.

e. Click Share.

After the remote user completes the edits:

41. Tap Share.

42. Tap Copy Link.

43. Switch to the Microsoft Teams app.

44. From the menu bar at the bottom, tap Teams.

45. Expand the Legal team, and then tap the General channel.

46. In the Chat field, paste the share link copied from the PowerPoint file.

47. In the Chat field, enter a message for the legal team: Please review and approve the brochure. Tap the Send icon.

48. Stop the timer.

Scenario 3: Easily Design a Creative Asset 

On the Surface Book 2:
1. Start the timer.

2. Open PowerPoint.

3. Tap Blank Presentation.

4. Tap in the title area, and then enter Title.

5. From the ribbon, tap Draw, use the Surface pen to tap the highlighter, and then highlight the title.

6. Tap the red pen icon, and then use the Surface Pen to draw two red squares and one red cube on the slide.

7. From the ribbon, tap Insert, tap New Slide, and then tap Blank slide.

8. In the Illustrations section, tap 3D Models > From Online Sources.

9. Tap Dinosaurs, tap the Tyrannosaurus Rex, and then tap Insert.

10. Resize the dinosaur to make it larger, and then rotate it to a profile view.

11. On the File ribbon, tap Save As, and then save the file to OneDrive as Dinosaur Project.pptx.

12. From the ribbon, tap Share.

13. In the Invite people field, add a user to share the file with, and then tap Share.

14. Stop the timer.

On the MacBook Pro:

1. Start the timer.

2. Open PowerPoint.

3. Click Blank Presentation.

4. Click in the title area, and then enter Title.

5. Use the highlighter tool to highlight the title text.

6. From the ribbon, click Insert > Shapes, and then click the rectangle shape.

7. Click and drag on the slide to draw a rectangle.

8. From the ribbon, click Shape Fill, and then select the white color fill.

9. Copy the rectangle and paste three copies on the slide.

10. From the ribbon, click Insert > Shapes, and then click the line shape.

11. Click and drag to draw a line on the slide.

12. Copy the line and paste two copies on the slide.

13. Reposition the three lines with two squares to form a cube shape.

14. From the ribbon, click Home > New Slide.

15. Open Safari, and then search for a Tyrannosaurus Rex image.

16. Right-click the desired image and select Copy Image.

17. Return to PowerPoint.
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18. Right-click in the new slide and select Paste.

19. Resize the newly pasted image to fit on the slide.

20. From the ribbon, click File > Save As, and then save the file to OneDrive as Dinosaur Project.pptx.

21. From the ribbon, click Share.

22. In the Invite people field, add a user to share the file with, and then click Share.

23. Stop the timer.

Scenario 4: Securely Manage Devices
On the Surface Laptop:

1. Start the timer.

2. Click the Start menu, and then search for Camera.

3. Click Camera to open the app.

4. Verify that the camera works as designed, and then exit the app.

5. Insert a USB storage device, such as a USB thumb drive.

6. Verify that the USB storage device is accessible and that you can view the contents of the device, and then safely remove the  
drive from the computer.

7. Click the Start menu, and then search for System.

8. Click System Control Panel.

9. In the Computer name, domain, and workgroup settings area, click Change settings.

10. On the Computer Name tab, click Change.

11. Select Domain, enter the fully qualified domain name (FQDN) of the domain, and then click OK. 

12. In the Username and Password fields, enter the credentials of a domain administrator account, and then click OK.

13. Click Close.

14. Click Restart now.

15. After restarting, log on using your domain user account.

16. Click the Start menu, and then search for Camera.

17. Click Camera to open the app.

18. Verify that the camera app no longer functions.

19. Insert a USB storage device, such as a USB thumb drive.

20. Verify that the USB storage device is no longer accessible.

21. Stop the timer.

On the MacBook Pro:

1. Start the timer.

2. Click the Apple icon, and then click System Preferences.

3. Double click Users & Groups.

4. Click the padlock.

5. In the User Name and Password fields, enter local administrator credentials, and then click Unlock.

6. Click Login Options.

7. Click Join.

8. Enter the FQDN of the domain.

9. In the User Name and Password fields, enter domain administrator credentials.

10. From the dock, click Launchpad.

11. Click Photo Booth.

12. Verify that the camera functions as designed, and then quit Photo Booth.

13. Insert a USB storage device, using a USB-C to USB-A dongle if necessary.

14. From the dock, click Finder.

15. Verify that the USB storage device is accessible.

16. On a Windows device, download the Mac System Center Configuration Manager client from Microsoft.com.

17. Run the System Center Configuration Manager client .msi file to extract the Mac OS-compatible Macclient.DMG file.

18. Using the USB storage device or a network connection, copy the Macclient.DMG file to the desktop of the MacBook Pro.
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19. Double-click the Macclient.dmg file to expand the compressed image file.

20. Double-click the CMClient.pkg file.

21. Click Continue.

22. Click Install.

23. Enter local administrator credentials, and then click Continue Installation.

24. Click Restart.

25. Log on to the computer using your local administrator credentials. The SCCM Configuration Manager Computer Enrollment dialog will appear 
automatically.

26. Click Next.

27. In the Username and Password fields, enter credentials of a domain administrator with System Center Configuration Manager 
enrollment rights.

28. Enter the FQDN of the System Center Configuration Manager server.

29. Click OK, and then wait for the profile settings to be pushed to the computer from the System Center Configuration Manager server.

30. Click the Apple icon, and then click Restart.

31. From the dock, click Launchpad.

32. Click Photo Booth and verify that the camera no longer functions, and then close the Photo Booth app. 

33. Insert a USB storage device.

34. From the dock, click Finder.

35. Verify that the USB storage device is no longer accessible.

36. Stop the timer.

Scenario 5: Work Efficiently on the Road
On the Surface Pro:

1. Start the timer.

2. From the Documents folder, open Brochure.pdf. (The file should automatically open in a Microsoft Edge® browser window.)

3. Scroll down to review both pages of the document.

4. Click the Start menu, and then search for Camera.

5. Click to open the Camera app.

6. Take a new picture for the brochure cover.

7. Click the Start menu, and then search for InDesign.

8. Click to open the InDesign app.

9. Click Open.

10. Open Brochure.indd.

11. Click File, and then click Place.

12. Place the image recently taken from the camera.

13. Click the right arrow to view the second page.

14. Click the background of the second image.

15. Click Color.

16. Edit the color levels to set Magenta at 85% and Black at 15%.

17. Click File > Export.

18. Click Save.

19. Click Export.

20. Open the newly exported PDF file.

21. Scroll down to view both pages of the document.

22. Stop the timer.
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On the iPad Pro:

1. Start the timer.

2. Tap to open the Files app.

3. Find and open Brochure.pdf.

4. Scroll down to review both pages of the document.

5. On the home screen, tap to open the Camera app.

6. Use the iPad Pro camera to take a new picture for the brochure cover.

7. On the home screen, tap to open the Photos app.

8. Tap the recently taken picture.

9. Tap the Share button, and then use AirDrop to share the photo with your MacBook Pro.

10. Switch to the MacBook Pro.

11. Click Accept on the AirDrop request, and then click Save to downloads.

12. From the dock, click LaunchPad.

13. Click Adobe InDesign.

14. Click Open, and then open Brochure.indd.

15. Double-click on the first-page background image.

16. Select the new photo you just transferred from the iPad Pro.

17. Click the right arrow to view the second page.

18. Click the background of the second image.

19. Click Color.

20. Edit the color levels to set Magenta at 85% and Black at 15%.

21. Click File > Export.

22. Click Save.

23. Click Export.

24. From the dock, click Finder.

25. Navigate to the newly exported file.

26. From the Favorites section of Finder, right-click AirDrop, and then click Open new window.

27. Click and drag the newly exported file into the AirDrop window.

28. Switch to the iPad Pro.

29. Tap Accept to accept the AirDrop share from your MacBook Pro.

30. From the Open with dialog box, tap Files.

31. From the Files window, tap iCloud, and then tap Add.

32. Tap to open the brochure.

33. Scroll down to review the brochure.

34. Stop the timer.

Scenario 6: Log on Quickly and Easily
On the Surface Book 2:

1. Start the timer.

2. Touch the touchpad to wake the device.

3. Look at the screen to log on.

4. Click the Start menu, and then click PowerPoint.

5. Click Open, and then open a file from OneDrive to verify account access.

6. Stop the timer.
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On the MacBook Pro:

1. Start the timer.

2. Tap the Touch ID sensor on the Touch Bar.

3. Enter your password.

4. From the dock, click LaunchPad.

5. Click PowerPoint.

6. Click Open, and then open a file from OneDrive to verify account access.

7. Stop the timer.

Scenario 7: Simplify Teamwork Using a Digital Whiteboard
On the Surface Pro:

1. Start the timer.

2. From the desktop, double-click the join.me icon to start join.me.

3. Select One time code.

4. Click the orange Play button.

5. Click the Send an email link.

6. Add a user in the To field.

7. Click Send.

8. In the How will you talk and listen? field, click Computer.

9. Click Start.

10. From the Start menu, search for Visio.

11. Click to open Visio.

12. Double-tap a blank drawing.

13. From the ribbon, click Insert, and then click Pictures from the Illustrations section.

14. Click the manager image, and then hold Ctrl and click the people image.

15. Click Open.

16. Click and drag the images to reposition them on the page.

17. From the ribbon, click Insert, and then click Online Pictures from the Illustrations section.

18. Use Bing to search for bulb.

19. Click the desired image.

20. Click Insert.

21. Click and hold to reposition the images.

22. From the ribbon, click Insert, and then click Pictures from the Illustrations section.

23. Click the meeting image.

24. Click Open.

25. Click and hold to reposition the image.

26. From the ribbon, click Review, and then click Ink from the Comments section.

27. From the ribbon, click Pens, and then click Color.

28. Tap bright red.

29. Draw a red circle around the bulb image.

30. From the ribbon, click Pens, and then click Color.

31. Tap blue.

32. Draw a blue box.

33. From the ribbon, click Pens, and then click Color.

34. Tap black.
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35. Draw a black arrow pointing from the blue box to the red circle.

36. Draw a black arrow pointing from the red circle to the group of images.

37. Label each figure in the people image with a name and an arrow pointing from the name to the image.

38. Return to join.me and tap the Chat button.

39. In a chat session, enter Please add tips in the blue box.

40. Wait for the other user to respond and click Request control.

41. Click Allow control.

42. Pause the timer.

43. Wait for other user to complete any edits.

44. Restart the timer.

45. From the ribbon, click File > Save as, and then save the file in a OneDrive folder.

46. From the ribbon, click File > Share.

47. Click Email.

48. Click Send as attachment.

49. Add a user in the To field.

50. Edit the Subject line to Please approve.

51. Tap Send.

52. Stop timer.

On the iPad Pro:

1. Start the timer.

2. Tap to open the join.me app.

3. Tap One-time code.

4. Tap Share link.

5. Tap Outlook.

6. Add a user in the To field.

7. In the Subject field, enter Join Me.

8. Tap the Send icon to send the message.

9. Tap the Select what to share icon.

10. Tap New Whiteboard.

11. Tap the Photo icon.

12. Tap Add photos.

13. Tap All Photos.

14. Tap to add the people image.

15. Tap to add the manager image.

16. Tap and drag to reposition the images.

17. From the home screen, open Safari.

18. Search for a bulb image.

19. Tap the desired image.

20. Tap and hold the image, and then tap Save image.

21. Switch back to join.me.

22. Tap the Photo icon.

23. Tap Add photos.

24. Tap All Photos.

25. Tap the bulb image.

26. Tap the photo icon.

27. Tap Add photos.

28. Tap All photos.

29. Tap the meeting image.

30. Tap the Pen tab.

31. Tap the Color menu, and then tap the red color. 

32. Draw a red circle around the bulb image.
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33. Tap the Color menu.

34. Tap the blue color.

35. Draw a blue box to the right of the red circle.

36. Tap the Color menu.

37. Tap the black color.

38. Draw an arrow pointing from the blue box to the red circle.

39. Draw an arrow pointing from the red circle to the group of images.

40. Label each figure in the people image with a name and an arrow pointing from the name to the image.

41. Tap the Chat icon.

42. In the chat session, enter Please add tips to the blue box.

43. Tap the three-dots icon.

44. Tap Export this document.

45. Tap Export as JPG.

46. Tap Entire whiteboard.

47. Tap Outlook.

48. Add a user in the To field.

49. In the Subject field, enter Add tips.

50. Tap the Send icon to send the message.

51. Tap the three-dots icon.

52. Tap Pass presenter role.

53. Wait for other user to present.

54. Wait for other user to perform the following steps:

a. Tap Accept to present.

b. Tap New whiteboard.

c. Tap the Photos icon.

d. Navigate to and tap the Exported Whiteboard image.

e. Tap the Pen tab.

f. Tap the Color menu.

g. Tap Green.

h. Draw three dollar signs in the blue box.

i. Tap the triple dots.

j. Tap Export as jpg.

k. Tap Entire whiteboard.

l. Tap Outlook.

m. In the To field, insert the manager’s address.

n. In the Subject field, enter Please review and approve.

o. Tap the Send icon.

p. In join.me, tap Chat.

q. In the chat field, enter Sent to manager.

55. Stop the timer.

Scenario 8: Complete Development Workflows Across a Suite of Applications
On the Surface Laptop:

1. Open Outlook on the web in the default web browser.

2. Start the timer.

3. Open an email message from the manager.

4. From the email message, copy the text that the manager wants changed.

5. Click the down arrow next to Reply all.

6. Click Forward.

7. Add the recipient user in the To field.

8. In the Subject field, enter See new design plan on share.
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9. Click Send.

10. Click Start.

11. Search for Visual Studio.

12. Click to run Visual Studio.

13. Click File.

14. From the Open menu, click Project/Solution.

15. Navigate to and open the test solution.

16. Expand Accessibility.

17. Expand Fetch timer.

18. Double-click Program.cs.

19. Paste the copied text into line three.

20. Click Build.

21. Click Rebuild solution.

22. Click Save all.

23. Click File > Exit.

24. Switch back to Outlook on the web.

25. Click the app launcher icon in the upper left.

26. Click SharePoint.

27. Click to open your SharePoint site.

28. Click Documents.

29. Click Upload.

30. Click Files.

31. Navigate to and upload the edited test solution from Visual Studio.

32. Click the app launcher icon.

33. Click OneNote.

34. From the Draw ribbon, click the Pen tool.

35. Click the blue color.

36. Using the Surface Pen, draw a test diagram of a cloud containing the text “Web,” and arrows pointing from the text “client” and “ 
server” to the web cloud.

37. Click Share.

38. Add a user to the share. 

39. Click Send.

40. Switch back to Outlook on the web.

41. Click to open the original email from the manager.

42. Click Reply all.

43. In the message’s body content, enter Done.

44. Click Send.

45. Stop the timer.

On the MacBook Pro:

1. Open Parallels Desktop and create a Windows 10 session.

2. Open Outlook on the web in the default web browser.

3. Start the timer.

4. Open an email message from the manager.

5. From the email message, copy the text that the manager wants changed.

6. Click the down arrow next to Reply all.

7. Click Forward.

8. Add the recipient user in the To field.

9. In the Subject field, enter See new design plan on share.

10. Click Send.

11. Click Start.

12. Search for Visual Studio.
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13. Click to run Visual Studio.

14. Click File.

15. From the Open menu, click Project/Solution.

16. Navigate to and open the test solution.

17. Expand Accessibility.

18. Expand Fetch timer.

19. Double-click Program.cs.

20. Paste the copied text into line three.

21. Click Build.

22. Click Rebuild solution.

23. Click Save all.

24. Click File > Exit.

25. Switch back to Outlook on the web.

26. Click the app launcher icon in the upper left. 

27. Click SharePoint.

28. Click to open your SharePoint site.

29. Click Documents.

30. Click Upload.

31. Click Files.

32. Navigate to and upload the edited test solution from Visual Studio.

33. Click the app launcher icon.

34. Click OneNote.

35. From the Draw ribbon, click the Pen tool.

36. Click the blue color.

37. Draw a test diagram of a cloud containing the text “Web,” and arrows pointing from the text “client” and “server” to the web cloud.

38. Click Share.

39. Add a user to the share.

40. Click Send.

41. Switch back to Outlook on the web.

42. Click to open the original email from the manager.

43. Click Reply all.

44. In the message’s body content, enter Done.

45. Click Send.

46. Stop the timer.

Scenario 9: Efficiently Create and Publish an Image Portfolio
On the Surface Book 2:

1. Start the timer.

2. Insert a MultiMediaCard (MMC) into the Surface Book.

3. Copy test pictures from the card to the local Pictures folder.

4. From the desktop, double-click to open Adobe Lightroom.

5. Click the plus icon to add files.

6. Navigate to the local Pictures folder and select the test pictures.

7. Click Review for import.

8. Click Add 5 photos.

9. Click the plus icon next to Albums.

10. Click Create Album.

11. In the album title field, enter Travel.

12. Click Create.

13. Select the three travel pictures.

14. Drag and drop the images into the Travel album.
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15. Click the plus icon next to Albums.

16. Click Create Album.

17. Enter Critters for the album title.

18. Click Create.

19. Select the two animal pictures.

20. Drag and drop the pictures into the Critters album.

21. Click the Travel album to view it.

22. Click the Taj Mahal photo to view it.

23. At the top right, click the Settings icon.

24. Under the Color section, expand the White Balance drop-down menu.

25. Select Auto.

26. Click the Healing tool icon.

27. Using the healing tool, click on open sky, and then click on dust spots in the image.

28. Repeat the previous step eight times until dust is removed from image.

29. Right-click the Travel album.

30. Click Share Album.

31. Click Copy.

32. Click Close.

33. Switch to the Outlook desktop app.

34. Click New email.

35. Add a user in the To field.

36. In the Subject field, enter Review.

37. In the message’s body content, enter Check these out:, and then paste the shared link into the message body.

38. Click Send.

39. Switch to the desktop and double-click to open Photoshop.

40. Note receipt of an Approved message from the manager, in response to your email.

41. Click File.

42. Click Open.

43. Navigate to the local Pictures folder, and then select the Clydesdale test image.

44. Click Open.

45. Click the Channels tab.

46. Click the Create new channel icon.

47. Toggle the channel visibility icon to Visible for the RGB channel.

48. Using the Surface Pen, trace around the horse in the image.

49. Click the Quick select tool.

50. Click Edit.

51. Click Fill.

52. Click OK.

53. Select the newly created channel.

54. Click the Load channel as selection icon.

55. Click the Layers tab.

56. Click the Lock icon to unlock the background.

57. Click the Add mask icon.

58. Click Channels.

59. Select the Alpha 1 channel.

60. Click Filter.

61. Under Blur, click Gaussian blur.

62. Click OK.

63. Click the Layers tab.

64. Click the New layer icon.
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65. Click and drag the new layer behind the first layer.

66. Select the new layer.

67. Click Edit.

68. Click Fill.

69. Expand the Contents drop-down menu, and then click Foreground color.

70. Click OK.

71. Click the Channels tab.

72. Select the created channel.

73. Click the Load channel as selection icon.

74. Click the Layers tab.

75. Click the newly created layer.

76. Click Edit.

77. Click Fill.

78. Expand the Contents drop-down menu, and then click Background color.

79. Click OK.

80. Click Channels.

81. Toggle the Channel visibility icon to Invisible for the created channel.

82. Click File.

83. Click Save as.

84. Expand the Save as type drop-down menu, and then select jpeg.

85. Click Save.

86. Click OK.

87. Click File.

88. Click Open.

89. Navigate to the local Pictures folder.

90. Select the Alhambra and Andromeda images.

91. Click Open.

92. In the Andromeda tab, click Image.

93. Under Image rotation, click Arbitrary.

94. Enter 57 degrees.

95. Click OK.

96. Click Image.

97. Click Image size.

98. Edit the width to 5000 pixels.

99. Click OK.

100. Right-click the image, and then click Copy.

101. Click the Alhambra tab to switch images.

102. Using the quick-select tool, click in the white space of the background.

103. Click the Layers tab.

104. Click the New layer icon.

105. Select the new layer.

106. Click Edit.

107. Under Paste special, click Paste into.

108. Click File.

109. Click Save as.

110. From the Save as type drop-down menu, click jpeg.

111. Click Save.
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112. Click OK.

113. Switch back to Lightroom.

114. Click the plus icon to add files.

115. Navigate to and select the two new jpeg files.

116. Click Review for import.

117. Click Add 2 photos.

118. Click the plus icon next to Albums.

119. Click Create Album.

120. Enter Portfolio for the album title.

121. Click My photos.

122. Select the two edited images and the three unedited images.

123. Drag and drop the files into the Portfolio album.

124. Right-click the Portfolio album.

125. Click Share Album.

126. Click Copy.

127. Click Close.

128. Switch to the Outlook desktop app.

129. Click New email.

130. Add a user in the To field.

131. In the Subject field, enter Portfolio.

132. In the message’s body content, paste the share link.

133. Click Send.

134. Stop the timer.

On the MacBook Pro:

1. Start the timer.

2. Attach the USB-C dongle with MMC to the MacBook Pro.

3. Double-click the MMC folder on the desktop.

4. Copy the test pictures from the MMC to the local Pictures folder.

5. Click Launchpad.

6. Click to start Adobe Lightroom.

7. Click the plus icon to add files.

8. Navigate to the local Pictures folder and select the test pictures.

9. Click Review for import.

10. Click Add 5 photos.

11. Click the plus icon next to Albums.

12. Click Create Album.

13. Enter Travel for the album title.

14. Click Create.

15. Select the three travel pictures.

16. Drag and drop the images into the Travel album.

17. Click the plus icon next to Albums.

18. Click Create Album.

19. Enter Critters for the album title.

20. Click Create.

21. Select the two animal pictures.

22. Drag and drop the pictures into the Critters album.

23. Click the Travel album to view it.

24. Click the Taj Mahal photo to view it.

25. At the top right, click the Settings icon.

26. Under the Color section, expand the White Balance drop-down menu.
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27. Click Auto.

28. Click the Healing tool icon.

29. Using the healing tool, click on open sky, and then click on dust spots in the image.

30. Repeat the previous step eight times until dust is removed from image.

31. Right-click the Travel album.

32. Click Share Album.

33. Click Copy.

34. Click Close.

35. Switch to the Outlook desktop app.

36. Click New email.

37. Add a user in the To field.

38. In the Subject field, enter Review.

39. In the message’s body content, enter Check these out:, and then paste the shared link.

40. Click Send.

41. Click Launchpad.

42. Click the Photoshop icon to start the app.

43. Note receipt of an Approved message from the manager, in response to your email.

44. Click File.

45. Click Open.

46. Navigate to the local Pictures folder, and then select the Clydesdale test image.

47. Click Open.

48. Click the Channels tab.

49. Click the Create new channel icon.

50. Toggle the channel visibility icon to Visible for the RGB channel.

51. Using the trackpad, trace around the horse in the image.

52. Click the Quick select tool.

53. Click Edit.

54. Click Fill.

55. Click OK.

56. Select the newly created channel.

57. Click the Load channel as selection icon.

58. Click the Layers tab.

59. Click the Lock icon to unlock the background.

60. Click the Add mask icon.

61. Click Channels.

62. Select the Alpha 1 channel.

63. Click Filter.

64. Under Blur, click Gaussian blur.

65. Click OK.

66. Click the Layers tab.

67. Click the New layer icon.

68. Click and drag the new layer behind the first layer.

69. Select the new layer.

70. Click Edit.

71. Click Fill.

72. Expand the Contents drop-down menu, and then click Foreground color.

73. Click OK.

74. Click the Channels tab.

75. Select the created channel.

76. Click the load channel as selection icon.
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77. Click the Layers tab.

78. Click the newly created layer.

79. Click Edit.

80. Click Fill.

81. Expand the Contents drop-down menu, and then click Background color.

82. Click OK.

83. Click Channels.

84. Toggle the Channel visibility icon to Invisible for the created channel.

85. Click File.

86. Click Save as.

87. Expand the Save as type drop-down menu, and then click jpeg.

88. Click Save.

89. Click OK.

90. Click File.

91. Click Open.

92. Navigate to the local Pictures folder.

93. Select Alhambra and Andromeda images.

94. Click Open.

95. In the Andromeda tab, click Image.

96. Under Image rotation, click Arbitrary.

97. Enter 57 degrees. 

98. Click OK.

99. Click Image.

100. Click Image size.

101. Edit the width to 5000 pixels.

102. Click OK.

103. Right-click the image, and then click Copy.

104. Click the Alhambra tab to switch images.

105. Using the quick-select tool, click in the white space of the background. 

106. Click the Layers tab.

107. Click the New layer icon.

108. Select the new layer.

109. Click Edit.

110. Under Paste special, click Paste into.

111. Click File.

112. Click Save as.

113. From the Save as type drop-down menu, click jpeg.

114. Click Save.

115. Click OK.

116. Switch back to Lightroom.

117. Click the plus icon to add files.

118. Navigate to and select the two new jpeg files.

119. Click Review for import.

120. Click Add 2 photos.

121. Click the plus icon next to Albums.

122. Click Create Album.

123. Enter Portfolio for the album title.

124. Click My photos.

125. Select the two edited images and the three unedited images.
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126. Drag and drop the files into the Portfolio album.

127. Right-click the Portfolio album.

128. Click Share Album.

129. Click Copy.

130. Click Close.

131. Switch to the Outlook desktop app.

132. Click New email.

133. Add a user in the To field.

134. In the Subject field, enter Portfolio.

135. Paste the share link into the body of the message.

136. Click Send.

137. Stop the timer.

Scenario 10: Switch Between Laptop and Tablet Modes
On the Surface Pro:

1. Start the timer.

2. Click the Start menu.

3. Search for Word.

4. Click to open Microsoft Word.

5. Click Open.

6. Click Browse.

7. Navigate to the 010-portionA.docx file.

8. Click Open.

9. Add the following text to the end of the document: They were drawing near to the place where there was an island in the river. The 
island was a good spot to make camp. It was isolated and had the protection of the surrounding water. They would sleep on 
the island tonight.

10. Click the Start menu.

11. Search for OneNote.

12. Click to open OneNote.

13. Click Add Page.

14. Enter Test Meeting as the page title.

15. Enter the following text on the page body: MEETING NOTES: Attendance: Bill, Ray, Ngan, Jose, Patty. Absent: none. Tardy: none. 
Accomplishments: Bill brought name tags for each person. Patty brought plastic protectors. We now look like a real team! 
Jose researched Java IDEs and is prepared to brief the team on available selections.

16. Switch back to the open Word doc.

17. Using the Surface Pen, circle three areas of the doc to cover in the meeting.

18. Disconnect the Surface Pro from the keyboard.

19. Swipe from the right side of the display to open the Windows side menu.

20. Tap Network.

21. Tap the connected wireless network.

22. Tap Disconnect.

23. Tap the cellular network.

24. Tap Connect.

25. Tap Start. 

26. Tap the Skype for Business tile.

27. Double-tap the user you want to connect with.

28. Tap the Phone icon.

29. Tap Skype call.

30. Tap the Screen icon.

31. Tap Share your desktop.
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32. Tap the Conversation icon.

33. In chat window, enter the following text: Here is the document we discussed.

34. Switch to the open Word doc to show the other user.

35. The other user responds in the Skype chat window with “Change the last sentence to: Lara fell asleep to the sound of the waves.”

36. Reply in the chat window with OK.

37. Switch to the open Word doc.

38. Change the last sentence of the doc to Lara fell asleep to the sound of the waves.

39. Tap File.

40. Tap Save as.

41. Tap OneDrive.

42. Tap Save.

43. Stop the timer.

On the iPad Pro:

1. Start the timer.

2. Tap the Microsoft Word app, and then tap Open.

3. Tap iPad.

4. Tap 010-portionA.docx.

5. Add the following text to the end of the document: They were drawing near to the place where there was an island in the river. The 
island was a good spot to make camp. It was isolated and had the protection of the surrounding water. They would sleep on 
the island tonight.

6. Tap the Home button.

7. Tap the OneNote app.

8. Tap New page.

9. Enter Test Meeting as the page title.

10. Enter the following text on the page body: MEETING NOTES: Attendance: Bill, Ray, Ngan, Jose, Patty. Absent: none. Tardy: none. 
Accomplishments: Bill brought name tags for each person. Patty brought plastic protectors. We now look like a real team! 
Jose researched Java IDEs and is prepared to brief the team on available selections.

11. Double-tap the Home button to switch to the Word app.

12. Tap the Draw tab, and then tap the Pen tool.

13. Use the Apple Pencil to circle three areas of the doc to cover in the meeting.

14. Tap the File icon.

15. Tap Save a copy.

16. Tap OneDrive.

17. Tap Save.

18. Double-tap the Home button.

19. Tap the Wireless icon to turn off Wi-Fi.

20. Tap the Cellular icon to turn on the cellular connection.

21. Tap the Home button to return to the desktop.

22. Tap the Skype for Business app.

23. Double-tap a user to connect with.

24. Tap the Phone icon.

25. Tap the Chat icon.

26. In the chat window, enter the following text: Please review the doc we discussed.

27. Double-tap the Home button and switch to the Word app.

28. Tap the Share icon.

29. Add a user to share with.

30. Tap Send.

31. The other user responds in the Skype chat window with “Change the last sentence to: Lara fell asleep to the sound of the water.”

32. Tap the chat notification to switch to Skype.

33. Reply in the chat window with OK.
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34. Double-tap the Home button and switch to the Word app.

35. Change the last sentence of the doc to Lara fell asleep to the sound of the water.

36. Tap Save.

37. Stop the timer.


